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Juliet Kemp is 
a system 
administrator and 
writer who spends 
far too much time 
on the internet. 
She remembers 
the joy felt when 
tabs first appeared 
and immediately 
opened about 20.
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expert

O
ne of the great things about Firefox is its use of add-
ons: pieces of code that you can install to make your 
browser work just the way you want it. The full list of 

what’s available can be found at https://addons.mozilla.
org/firefox, but with somewhere in the region of 5,000 add-
ons, it can be hard to know where to start, so we’ve compiled a 
list of some of the best to get you started.

Add-ons are easy to install: most of them can be obtained 
by going to the Tools > Add-ons menu option and searching 
for add-ons in the Get Add-Ons tab. You’ll usually have to 
restart Firefox after installation for the changes to take effect. 

Some add-ons have options you can set, which you access 
in the Extensions tab. This is also where you remove add-ons. 
Some add-ons will even install an item in the Tools menu that 
enables you to change settings. If you don’t like the way an 
extension behaves, it’s worth checking out its options and 
settings before you uninstall it. 

The add-ons here were all tested in Firefox 3.6, which is the 
current stable version, but may not be the version shipped 
with your distribution. Most add-ons ought to work with 
anything over version 3.0, or you can install 3.6 from the 
Mozilla website at www.mozilla-europe.org/en/firefox.

Firefox: Boost        

Firefox Enhance your browser with 
the best add-ons known to mankind

The list of Firefox add-ons is so long that it can become quite bewildering. 
Juliet Kemp gives you a helping hand by picking out a selection of the best.

Part 1 Change the way your browser looks

Fox Splitter
The first thing we’ll look at is Fox Splitter, which 
enables you to split up your browser screen into 

multiple smaller windows, either vertically or horizontally. You 
can repeat this step as many times as you like.

Obviously, this is going to be more useful for you if you’ve 
got a large screen – if you’re on a netbook, it’s probably not 
worth it. But given enough space, it can be really useful, 
especially if you’re doing something like research and want to 
be able to compare several pages side-by-side; or if you’re 
writing a blog post/comment or an email and want to be able 

to check whatever you’re quoting from without jumping 
between tabs every few seconds. 

One neat feature is the little red pin that enables you to 
synchronise scrolling between panes, so that as you scroll in 
the main pane, the synchronised pane does the same. This 
works both vertically and horizontally. Another one is the 
drag-and-drop support: drag a link to the middle of the right 
side of the current pane and a little arrow box shows up. Drop 
the link there and it’ll open up in a new pane in the direction 
the arrow was pointing.

Stylish
Stylish makes it easy to change the style of 
particular sites. You can install a user-created style 

from the http://userstyles.org website (or elsewhere), or 
write your own styles. All of them are quick to install and 
easily managed via the S icon in the bottom right-hand corner 
of the status bar.

The http://userstyles.org site has over 23,000 styles 
available on it. Given their enormous popularity, it’s perhaps 
unsurprising that the sites appearing most in the list seem to 
be Facebook, YouTube and Google. We liked YouTube Cleaned 
Up, which removes some of the cruft from YouTube; and there 
are many, many versions of YouTube with a black background 
available as well. Hello Kitty Facebook is also bizarrely 
popular. Each to their own… 

 Fox Splitter is a great way to view two websites alongside 
one another, and you can set them to scroll simultaneously.
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If you missed last issue Call 0870 837 4773 or +44 1858 438795.

You can search for styles applicable to a particular site, 
which can be useful. There are several Guardian and BBC 
styles available, often to produce a more minimal site 
experience. Quite a few styles block ads (but we’ll look further 
at ad-blocking later on). We also found a Metafilter style that 
gives a black/blue on white background, which is far easier 
on the eyes than their normal murky blue.

Unfortunately, http://userstyles.org suffers from the 
same problem as any other site that relies on user-provided 
content: not all of the styles available are actually any good, or 
even do the thing that they claim they do. Plus, there’s always 
the risk that a site will change its CSS template, which will 
also break the user style. 

More useful is probably the interface that Stylish provides 
to help you write your own styles for a particular site. This 
makes it easy to set up a simple change (such as a 
background colour change) to your own specifications for a 
site you use regularly. Be aware that there’s a possible 
security problem with user styles if they contain XBL bindings 

        your browsing

If you haven’t 
already used 
Greasemonkey, try 
it – it enables you 
to customise any 
web page using 
JavaScript. See 
LXF118 for more.

Quick
tipPart 2 Navigate the web more easily

 Browse the 
internet using 
your keyboard, 
thanks to the 
GleeBox add-on.

One-shot wonders
FoxClocks This shows the time in 
various parts of the world in the bottom 
bar of your browser. It’s invaluable if you 
have colleagues or friends in other time 
zones and would prefer not to wake 
them up at 3 am. 
Automatic Save Folder Set up where 
you prefer to save particular types of file, 
based on the filename. 
Better Gmail 2 Adds various features 
to Gmail, including hierarchical labels 
and an unread message icon on your 

browser tab. It’s a package of 
Greasemonkey scripts. 
RightToClick Enables you to right-click 
and highlight part of a page that 
JavaScript doesn’t want you to.
SkipScreen Skips the intermediate 
screens on some file sharing sites such 
as RapidDownload. 
Firebug A must-have for web 
developers. This enables you to edit, 
monitor and debug HTML, CSS and 
JavaScript live. 

(which can contain executable code). Styles on 
http://userstyles.org aren’t allowed to include XBL bindings, 
but be wary of styles that come from elsewhere. 

GleeBox
Many people find that switching as much control as 
possible to the keyboard rather than the mouse is 

beneficial for backache and wrist strain. GleeBox gives you 
better keyboard access to your browser, which otherwise 
requires you to use your mouse a lot.

This is an experimental add-on, so you can’t install it 
directly from the Add-ons window. You have to go to the Add-
ons web page and click the Let Me Install This option to 
enable installation.

Once you’ve installed it and restarted Firefox, find a link in 
the current page that you want to open. Press G to bring up 
the GleeBox search and start typing the name of the link. 
When it’s highlighted, hit Return to open it, or Shift+Return to 
open it in another tab. If there are multiple matches, you can 
hit Tab to move between them.

You can also set GleeBox up to search your bookmarks. If 
you visit links in your bookmarks particularly frequently, you’ll 
no doubt find this useful. Enable it by checking the relevant 
box in the Features section of its Options screen. 

GleeBox isn’t restricted to links. You can also use it to 
navigate within a page. Hit G, then type ?h to select all the 
headings (h1, h2 and h3 levels). Move between them with Tab 
and Shift+Tab. Further options include !share t to share the 
current page on Twitter (other services you can use include 
Gmail, Facebook, Digg and Delicious). Type 
![bookmarkletname] to run a bookmarklet with a particular 
name. We loved this last one for running the Zap bookmarklet 
we have that gets rid of all page formatting – great for when 
your random surfing comes across a page with hot pink text 

on a yellow background. (To change the look of a site you visit 
regularly, have a play with Stylish, as mentioned above.)

GleeBox also interacts with YubNub, which effectively 
provides a ‘command line for the web’. To try this out, press G 
and then type: 
:xe -amount 100 -from USD -to GBP

You’ll be sent to the www.xe.com currency site, which will 
helpfully tell you how much $100 is in pounds sterling today. 
Check out the GleeBox manual and the YubNub website for 
more, and to create your own YubNub commands.

FireGestures
FireGestures goes the opposite way from GleeBox – 
it makes more commands accessible via the mouse 

only, without needing to go to one of the keyboard buttons. 
The default setting for most of the commands is to use what 
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Check out the 
Collections option 
on the Mozilla Add-
ons page to get 
sets of add-ons that 
work well together.

Quick
tip

sharing services), but you can change the options via the 
Tools > FastestFox menu. If you’re tweeting the highlighted 
text, it does the right thing with links by giving both the label 
and the link. The widget is particularly handy if you’re into 
using Twitter a lot, but it’s also really useful for speeding up 
your searching.

FastestFox also enhances the search facility in the URL bar, 
to include results from a Google search for what you’re typing 
in the drop-down, as well as the history search results that 
Firefox provides automatically. If you do a regular Google 
search, it will also provide suggested search refinements – 
click on one of these and it’ll give you a refined search page. 
You can also search for something book, and it’ll give you a 
set of Amazon links for book, but unfortunately this is for 
amazon.com only and not the UK site, and there’s no option 
to change it.

You can disable any part of FastestFox from the Tools 
menu, so you can limit it just to provide the tools that you like 
and not those that irritate you.

across more than one instance of Firefox. Just install the add-
on, set up an account when you’re asked to (or log into an 
existing account if you have one), and your bookmarks will be 
merged into your synchronised set. 

This is massively useful if you regularly find yourself at 
home looking for a bookmark, then remembering that you 
saved it on your work computer, or if you have to transfer 
bookmarks between your laptop and desktop machines 
manually. Even better, it’ll sync across different browsers, and 
now supports Internet Explorer, Google Chrome and Safari, 
as well as Firefox.

If you don’t want all the bookmarks from your home 
computer being synchronised to your work machine, you can 
set up profiles to restrict which bookmarks are shared with 
other computers. This means you won’t have all your work-
related bookmarks cluttering up your personal machine at 
home, for example.

XMarks has a couple of other features that are less useful 
but still interesting to know about: it’ll flag up the most-
bookmarked sites on your Google search results, and if you 
click on the icon in the address bar, it’ll tell you more about 
the site you’re on, and suggest other similar sites that might 
be of interest to you. This is a handy way to discover new 
content on the web.

Part 3 Work with bookmarks

 The Delicious sidebar enables you to search your bookmarks from Firefox.

 FastestFox has a Also Search On box and the search/
Twitter widget is shown here next to the highlighted text.

FireGestures calls Mouse Gestures (hold down the right 
mouse button and move the mouse), but various other 
gestures are also supported, including using the mouse 
wheel, the ‘rocker’ (hold down the left button and click the 
right, or vice versa), and mouse-plus-keypress. 

We particularly liked the tab wheel gestures, which aren’t 
switched on by default. These enable you to scroll the mouse 
wheel on the tab bar to switch between tabs. You can also 
scroll the wheel while holding the right button down to view a 
list of all tabs, which you can then continue to scroll down. 
The only downside with this option is that the list doesn’t 
scroll, so if you’ve got so many tabs open that that they run 
off the bottom of the screen (not that we would ever let our 
browsers get that cluttered…), you can’t get to them this way.

By default, mouse trails are on, so you get a track in green 
of where FireGestures thinks your mouse has been, but 
fortunately, this is only when you’re performing mouse 
gestures and not all the time. This is an improvement on other 
gesture add-ons we’ve used in the past, but it can be turned 
off if you find it annoying. 

FastestFox Plus
FastestFox Plus (formerly known as SmarterFox) 
aims to speed up your web browsing in a number of 

ways. One feature we found useful almost as soon as we 
installed it is the Endless Pages facility. It detects if there’s a 
Next Page link on a page (such as those found at the bottom 
of a blog), loads up the next page and dumps it underneath 
the current one as you scroll downwards. This makes it even 
easier to waste hours going back through blog archives, 
because now you don’t even need to click a link to do so. 

Another neat feature is the small bubble widget that pops 
up if you highlight a section of a web page, giving you the 
option to tweet the selection, or to look it up on various 
services. By default, these are Wikipedia, Google, or OneRiot 
(which indexes links shared on Digg, Twitter, and other social 

XMarks
If you use Firefox on more than one computer, and 
you haven’t got XMarks installed, you’re missing 

out. XMarks enables you to synchronise your bookmarks 
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Part 4 Controlling your browser and privacy

“Unlike regular cookies, 
Flash ones are excluded 
from privacy controls.”

Games and oddities
Consciousness Bell Plays a Tibetan 
bowl chime at random intervals to 
remind you to be mindful.
about:kittens Replaces the Firefox logo 
in the About box with a random picture 
of a kitten. Get your kitten fix here!
Destroy the Web We’re pretty sure that 
this shouldn’t be as much fun as it is. 
Destroy the Web temporarily turns any 
web page into a shoot ’em up game. 
Click on elements to destroy them 
(complete with explosion soundtrack!) 
and save your score at the end. 

 We couldn’t resist juxtaposing this 
kitten with www.dailymail.co.uk.

which can show either recent bookmarks, tag bundles, or 
favourite tags. In theory, tags, tag bundles, and favourite tags 
can all be managed via the add-on, but in practice, it’s usually 
more straightforward to do this on the Delicious homepage. 

If you’re a Delicious user, the tag-this-page button alone is 
worth installing this add-on for. The Save window it pops up 
enables you to add your own title, notes, and tags (there’s 
also a suggested tags button) to choose a service to send 
your bookmark to, and to mark the bookmark as private. 
The ability to search your list of bookmarks from a sidebar 
is an added bonus.

Flashblock
Flashblock has long been a favourite Firefox add-on 
for many users who find Flash content irritating and 

intrusive. Flashblock simply replaces any Flash stuff with a 
blank box and a little Play button in the middle. If you want to 
see the Flash content, click the button and off you go. If you 
don’t, ignore the whole thing. It’s just like magic. 

You can specify particular sites to exclude from the block, 
which is useful if you frequent pages that aren’t usable 
without Flash and you don’t want to have to keep on clicking 
through. Flashblock is one of those lovely pieces of code 
that’s straightforward, simple, and just works. Plus, you’ll 
never get rickrolled again, which has to be a good thing.

NoScript 
Another straightforward one, this disables 
JavaScript, Java, and other executable content. You 

can enable it from specific domains that you’re happy to 
trust. Initially, you’ll find that the vast majority of sites you visit 
will trigger the pop-up box along the bottom, warning you that 
scripts have been blocked. You can change the settings so 
that it doesn’t display this box, and rely on the status bar icon 
instead, if you prefer. 

There are simple options to permit a site to run scripts – 
temporarily or permanently – so as you surf, you’ll teach 
NoScript what is and isn’t OK, and it’ll become less intrusive. 
However, if you spend a lot of time clicking around and 
reading new sites, you may find it a bit too much. 

There are some changes you can make via the options, 
but ultimately, you may have to choose between paranoia 
and ease of browsing. 

AdBlock Plus
You probably have this already, but it’s worth 
mentioning again just in case there’s someone out 

there who hasn’t encountered it. AdBlock Plus blocks ads and 
banners of all sorts. 

You can add things to block manually by right-clicking and 
choosing AdBlock from the contextual menu, or just 
subscribe to a content filter (either when you first run it or by 
going to the Preferences menu) and most ads will be blocked 
by the automatically updated filter. You can also exclude 
particular items from being blocked if you’ve got a false 
positive that’s causing problems. 

We’ve used AdBlock Plus for a long time, so we disabled it 
briefly while we were writing this tutorial to make sure it was 
still actually doing something, and thus worth recommending. 
We were both pleased (it is definitely working!) and faintly 
horrified (there’s so much ad-related rubbish out there!) by 

what happens when it’s not switched on. After five minutes of 
clicking around, we turned it back on with a sigh of relief. It’s 
very strongly recommended indeed if adverts on web pages 
make you want to put a fist through your screen.

BetterPrivacy
Many websites use ‘Flash cookies’, which are objects 
that store information to track users and keep 

details about them. Unlike regular browser cookies, Flash 
ones are excluded from the browser’s privacy controls, 

More importantly, even if you’ve set your browser up to 
delete all your cookies when you shut it down, Flash cookies 
won’t be deleted. You can change these settings via the 
Adobe website, but the usability is, shall we say, not great. 

BetterPrivacy fixes this, and enables you to control how 
long Flash cookies are kept for. You can also browse through 
the Flash cookies 
that are already 
stored on your 
computer to see 
what’s going on. 
We were somewhat 
shocked at the size 
of the list on our test system, with some of the entries dating 
back to 2007. We deleted all of them, and haven’t noticed any 
problems since doing this.

Note that, as with regular cookies, if you delete everything 
every time you shut down your browser, you may find yourself 
removing things that you actually wanted to save. You can set 
exclusions to prevent this though, which is useful. 
BetterPrivacy is another must-have add-on if you’re at all 
concerned about your online privacy.  LXF

Delicious Bookmarks
Rather than using your browser for bookmarking 
web pages, you may prefer to keep some or most of 

your bookmarks in a web-based service like Delicious, which 
enables you to tag and add notes to them, and then share 
your links with others. The Delicious Bookmarks add-on 
makes working with those bookmarks easier.

It installs three toolbar buttons: one for adding the current 
page to Delicious, one to open up a sidebar with all your 
Delicious bookmarks in for searching, and one to open your 
Delicious homepage. There’s also Delicious’s own toolbar, 
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